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STAAD.Pro:- STAAD Training

1. Introduction

This course is structured to look at the scope of the STAAD.Pro commands and capabilities.
There are six exercises to complete, each one containing more STAAD commands and
dealing with more complex problems.

This document has been produced for your benefit and assistance. This document is

copyright and no part of it is to be copied, reproduced electronically or otherwise without the
prior written consent of Research Engineers.

2. Revision History

Date Version | File Ref. Details By
17/06/98 1.0 STAAD Pro Training First Issue CA
10/03/99 | 1.0 STAAD Pro Training Second and third examples CA
added
19/08/99 | 1.1 STAAD Pro Training Updated for v3.1 CA
25/08/99 [ 1.1 STAAD Pro Training Dynamic example added CA
06/09/99 11.2 STAAD Pro Training RC Designer added CA
01/05/00 | 1.3 STAAD Pro Training Updated to STAAD 2000 CA
01/11/00 |14 STAAD Pro Training Detailed steel design examples | CA
added.
24/09/01 {15 STAAD Pro Training Updated for STAAD 2001 ME
28/06/02 | 1.6 STAAD Pro Training Updated for STAAD 2002 ME
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4. Principles of STAAD.Pro - STAAD

STAAD.Pro - STAAD is an analysis and design software that uses a graphical user interface
to generate a data file that is processed by an analysis engine. It can also view the results in

the post processing mode.

1) Modelling
The modelling stage of the process works with an ascii file format that has a file extension

* STD. This is opened by STAAD.Pro - STAAD and creates an internal database which the
Graphical User Interface (GUT) then wi.ris with.

Analysis

STAAD/Pro Engines
GU1

2) Analysis

When the modelling is complete and an analysis is required, the input file is updated and this
is passed into the acalysis engine. As there are so many design engines, when the analysis is
started, STAAD.Pro - STAAD must de informed which analysis engine is to be used.

Input File
(*.STD)

Analysis

STAAD/Pro Engines
GU1

Modelling | Results

STAAD Pro Training 1.6.sg.doc page 4 0f 59
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3) Post Processing

Completion of the analysis produces two sets of output. As the input file is processed, an
output file with the same filename, but a .ANL extensicn is produced which can be viewed
either within STAAD.Pro or an ascii file viewer. The analysis process also generates
additional database files that are used with the GUI so that the user can interrogate the results.

Input File
(*.STD)

Analysis
Engines

Input File
(*.STD)

STAAD Pro Training 1.6.sg.doc page -5 0f 59
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STAAD.Pro:- STAAD Training

5. Important Windows Concepts

There a number of general features of Microsoft Windows that are worth noting in order to
make the most of the STAAD.Pro graphical environment. :

Toolbars
(Floating)

1) The Active Window.

STAAD.Pro is a MDI (Multiple Document Interface) program. That is the program operates
with a number of “child © windows within the main STAAD Window. The child window can
be either text based, such as the tables, graphical such as the diagrams or dialogue boxes. Any
operation is carried out on the ‘Active’ window. The active window can be identified by the
dark title bar. (Note although this is true for standard Windows setup, the colour
configuration can be altered from Windows Control Panel.) By clicking the mouse on a child
window, that window becomes the active window. The menu and toolbars respond to the
active window so that only those commands that are appropriate to the active window are
available.

2) Menus
The primary method of accessing all the commands available in STAAD.Pro is from the

‘Main menu’ which runs across the top of the main application window. Note that this menu
is sensitive to the active window. For example, if the active window is a table, then the

(R
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command ‘Copy Picture’ does not appear in the EDIT menu.
as ‘Floating Menus’ available by clicking over a window with the right mouse button. These

floating menus have comman
quicker.

ds that are available elsewhere

There are also features known

but a right click can get to it

The ‘Page Control menu’ 18 unique to Research Engineers. This can be considered as a file

management system. When turned on, the Page C

ontrol menu 18 fixed to the left of the main

window and has two uses. Firstly it can be used to step through the stages of creating a model
and secondly as a desk tidy, re-organising the child windows.

Floating or
Pop-up Menu

3) Toolbars

.

STAAD.Pro can access 2 number of the more common commands by clicking buttons on
toolbars. These toolbars can be either ‘Docked’ to the sides of the main window of ‘Floating’
free. The buttons that each toolbar contains can be customised by selecting the “Toolbars...”

option from the View menu.

4) Selection Methods
There are several methods of

making mu.apie seiecons o Windows that have been utilised

by STAAD.Pro. Within a text window, suck as the nodes of slements wmbles. 1018 possible to
click in a label to select the row, and by holding &€ Retbel

will also select all items in-between. Also, by hoidimg 22
item to the currently selected list.
either nodes, elements, etc. depending on the

wrile chcking oo anoher label

conzol kev Cown will add that
Within a graphica wipdow. pommt and &l
curren: sELECTOT TRSS byt D

ek wil seiect

v holding the

mouse button down ad dragging, 3 selection box wil 22 crezred which Wikl aciude all 1tems
whose greater part is within the box. As with ext w1ndows. B holding the ‘control’ key
add these to the current selecion.

while making a selection, will

5) Useful Keys

The graphical windows showing the structure can be rotate
data into dialogue boxes the ‘tab’ key changes between input

cursor keys. When entering
fields.

d from the keyboard using the

STAAD Pro Training 1.6.s8.doc
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6. Example 1 -

This example shows some of the most basic functionality needed to quickly create, analyse

and print a report.

2D Beam Model

T o 2
| | lsm |
| | i
-
L .
e 1 &

. vi¢ A
- . R - D 9 ('/L‘/}
S T S A S = heed A
[~ Dispieymis diadog et St Ve ] Net> ] Cancet [ Hete J{ - i/v,/ “n -

_""_',

These set the unit types of objects that are created such as plate thickness and loading.

STAAD Pro Training 1.6.sg.doc
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2) Snap Node / Beam

Go to the Geometry Page, staying on the Beam sub-page. This arranges a window to display
the structure and nodes and beams tables. As there is no structure yet defined, the ‘Snap
Node/Beam dialog is automatically opened displaying a grid on the structure so that nodes and
beams can be added graphically.

1. In the Snap Node/Beam dialog, set the grid plane to the X-Y plane. Note the axes in the
lower left corner of the structure window.

2. Click on the 'Front View' g button to get a front on view (X-Y plane) of the
grid.
3. To set the grid to suit the dimensions of the structure modify the spacing to:-
X, 8 bays at 1.500m c/c

Y, 1 bay at 3.500m c/c

4. Note that the origin is set to 0, 0, 0. This is indicated on the grid as a circle. As you move
the cursor over the grid, note the co-ordinate shown in the lower right corner which can be
used as a visual check.

5. Click on the origin to generate a node.
6. Click on the grid line above to a new node and generate a column. Note the co-ordinate

should read 0.000, 3.500, 0.000.

7. Click on the extreme top right comer of the grid, 12.000, 3.500, 0.000 , to form a
horizontal beam. Follow this by clicking in the lower right corner, 12.000,0.000, 0.000, to
form a column.

8. Now whilst holding down the CTRL key (only a node is required, not a beam) and click
on the horizontal beam 5 bays from the left hand side at co-ordinate 7.500, 3.500, 0.000.

9. To insert the final column, without holding down the CTRL key, click on the grid below
the last node to create a new node at 7.500, 0.000, 0.000, along with the column.

STAAD Pro Training 1.6.sg.doc Page -9 0f 59
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g

The screen should look something like this:-
S Pro - tingt.sid )

Click on the Close button to turn off the grid..
All the node co-ordinates and beam numbers have been automatically created. From d
Structure toolbar click on the ‘Symbols and Labels’ E button and turn on the ‘Node
Numbers’ and ‘Beam-Numbers’. L1410

The format and locations of labels can be modified by selecting Options from the ;dlt menw

3) Insert and Move a Node
From the Structure toolbar press the ‘Insert Node’ i button. Note that the cursor Las|
changed shape when over the structure window. From the structure window select beam!
number 2, the top element of the larger span. In the resulting dialogue box press the ‘Add mud
point’ button and ‘OK’.

Change the selection cursor from the ‘Select’ menu to ‘Nodes Cursor’.

Again note the change to the cursor when above the structure window. Select the newiv
created node and click with the right mouse button to get a Floating menu. Select ‘Move’
from the menu and enter 1.5 into the Y: field of the dialogue box that is presented. And clicx
on OK.

STAAD Pre Training 1.6.5g.doc Page -10 of 59
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4) Assign Properties (Database)

Change to the General Page, staying on the Property sub-page. From the ‘Assign
Properties’ Dialogue box press the ‘Database...” button. Select a ‘UB 356x127x33’ from the
British database. This is the first item of a list of sections that will be used on the structure,
more can be added in the same way.

The structure should now look like the following diagram;

Note that when a section is chosen from the database in this way, it has associated with it a
material property that will also get assigned when this section is assigned to the beams of the
structure.

Select the 356UB from the list, select on the option ‘Assign to View’ and click on the
“Assign’ button. All the elements in the structure now have this section property.

STAAD Pro Training 1.6.5g.doc Page-11 of 59
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5) Assign Supports
Staymg in the General Page change to the Supports Sub-Page. Create a fully fixed suppent
the ‘Support’ dialogue by clicking on the Add button. To attach this support to the
tructure select the support in the dialog box, check that the Assignment method is set 10 "Use
cursor to Assign’ and click on the ‘Assign’ button. The cursor changes to the suppor: :com
when over the structure window. Click over the bases of the columns to provide the support §
The structure should now look like this. |

6) Assign Releases
Staying in the General Page change to the Spec Sub-Page. Create a release by click:ng
the ‘Beam...” button and define a release that is free in MZ and occurs at the start. Ass:gm

~

to member 4. A -

'
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7) Assign Loads

Staying in the General Page change to the Loads Sub-Page. When entering this page, a
loadcase must either be selected or defined. Thus for the first time the loadcase must be
created. Enter the title ‘Dead’ and click on OK. The beam load needs to be created, thus
click on the ‘Member...” button. Select the Uniform Force tab and enter the value —22 kN/m
into the W1 edit box and as a Projected load is required, set the direction to PY and click on
the Add button.

This creates a load that can be applied to the structure. This time, pre-select the three roof
beams 2, 4 and 6. With the assignment method set to 'Assign to Selected Beams', click on the
Assign button. -

8) Analyse
To define the method of analysis and additional information that is required in the standard
output file. Change to the Analysis/Print page and go to the Analysis sub-page. Click on the
‘Define Commands...’ button. On the Perform Analysis' tab, with No Print selected, click
on the Add button to insert the command, followed by the Close button. The file is now
ready to be analysed, but can be checked in the text editor by clicking on the Editor [

button. At this point the file is saved to disk and is shown thus:-

View the file and close it without modifications, or STAAD will reprocess the file returning to
the graphical environment.

Click on the ‘Analyze’ menu and select ‘Run Analysis...’ On the 'Analysis Option' tab,
ensure that the 'STAAD Analysis' option has been selected and click on the "Run Analysis...”
button. Save the file if required.

Once the analysis has been completed, click on the Done button to close the analysis engine.
The structure now has results which can be viewed.

STAAD Pro Training 1.6.sg.doc Page -13 of 59
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9) Results - Displacements

To view results, the program needs to be switched to the Post Processing Mode. This can be
done either from the Mode menu or by clicking on the Post Processing button. If
there are 1o results available for a structure, then this button is disabled.
When entering this mode, the results to be displayed in the tables has to be selected. Use the
‘>>” button to select loadcase 1 Dead' and click on the OK button.

The first page that is entered in the Post Processing mode is the Node page with the
Displacements sub-page. The structure is displayed with the displacement diagram,

"However the displacement scale needs to be set to an appropriate value. Click on the Scale

button and set the displacement scale to 10 mm/m.

Identify the displacements of nodes in the table by clicking on the nodes on the diagram and
select a displacement in the table and note how it is located on the structure.

As this is a plane structure, the displacements in the Z direction and the rX and rY directions
are all zero and thus not required. The widths of columns can be resized, or set to zero and
thus the size of the table can be reduced.

STAAD Pro Training 1.6.5g.doc Page - 14 of 59
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10) Results - Forces

To view the forces on the beams, change to the Beam page and stay on the Forces sub-page.
The structure diagram is displayed with the Mz moment (major axis) and the Beam End
Forces Table. Note that clicking on the table or the diagram highlights the beam in the other
window. To add values onto the diagram, maximise the Whole Structure window. Click on
the Results menu and select the ‘View Value...” option. On the 'Ranges' tab, select the
"Ranges' option and enter 2 into the 'Beams' edit box. Then change to the Beam Results' tab,
click on the Bending Ends check box and click on the Annotate button. The labels have
been added, but may not be sufficiently clear, so re-size the font. To do this click on the View
menu and select the 'Options...' menu. On the Annotation tab, click on the Font button and
set the font to 12pt, bold. Click the OK button on the font and Apply on the Options dialog
to show as below.

STAAD Pro Training 1.6.sg.doc Page-15 of 59
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To get individual bending moment graphs, change to Graphs sﬁb—page. Click on the beams
of the structure to view the bending moments, shear forces and axial force diagrams in the
windows on the right hand side.

To view different diagrams, such as the beam combined stresses, click on bottom graph
window to make it the active window. Click with the right mouse button over this window
and select the ‘Diagrams...” option from the floating menu. Click on the Stress option to
turn it on and on the Axial option to turn it off. Click on OK to accept the change to produce
a page layout similar to this:-

11) Printout — Output File
There are two reports that can be printed. Firstly the Output file that is automatically created

by STAAD as the analysis is performed. To view this file press on the STAAD Output
button. This is the form of output STAAD III users will be familiar with,

12) Printout — User Report

The second method is to use a User Report. With this method information can be selected and
organised for a particular situation, including tables and pictures. Pictures can be any
graphical view of the structure, including results. Take a picture now, ensure that the required
window is active, and click on the Take Picture button. |@#] Accept the default
comment. This becomes Picture 1, any number of pictures can be taken and added to a
User Report.

T2 Pro Traming ! 6.sg.doc Page -16 of 59
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IS

,

To setup a User Report, click on the Report Setup button. Select Nodes and Beams
from the Input, select Node Displacements from the Output and Picture 1 from the
Picture Album. Click on the 'Load Cases' tab and select the Dead loadcase. Click or: GX to
accept this report setup.

Finally click on the Print Preview

This concludes the exercise Example 1.

STAAD Pro Training 1.6.sg.doc Page-17 of 59
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7. Example 2 - 3D Beam and Plate Model with Steel Design

This example expands on the model created in Example 1.

1) Generate 3D
There are a number of generation tools available in STAAD.Pro. They are accessible from

the Geometry menu or the Generate toolbar. . fimemuiy 5

; s
Open the model from Example 1 and save as 'Example 2'. Go to the Geometry page. Use
the Beams cursor to select all the beams. Click on the Translational Repeat button on the
Generate toolbar or select the 'Translational Repeat..." item from the Geometry menu. In the
dialog box, set the direction to the Z axis, 5 steps @ 5Sm c/c, but change the third bay to 6m.
Tick the Link bays and Open base options. Click on the OK button to generate the structure.
Note how the section profiles, supports and loads have been copied onto the new frames, but
properties have to be added onto the linking members.

2) Add Beam Elements
Beam elements can be added graphically onto the structure view windows.
Click on the Add Beams

button on the Geometry [ toolbar, Note how the cursor

changes when it is over structure view.
Add bracing elements by clicking on the start joint and end joints of the end frames as per the
above diagram, rotating the structure if necessary.

As With the lmk beams from e TR e P ST ft»"""““““"f‘“‘“' TS IS e o s s L e e o

above, these new beams also -- EEI—I-Q»J—'*EH?—‘EE*-
need properties. Go to the |
Property sub-page and add a § " oo e
'UB 254x146x31' from the § . .0 oad

British Database. i T
To assign the new_property, -

click on the Side View button, {
select the link béams and the §
diagonal bracing, highlight the 1
new property and click on the :
Assign button. 7 :
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3) Add Plate Elements

STAAD.Pro models can include plate and solid elements. Set the plates to be filled. From the
View menu, select Structure Diagrams. Select Fill Plates/Solids and Sort Geometry.

Start the Snap Node Plate dialog by clicking on the Snap Node/Plate ] button on the
Geometry toolbar.

Locate the origin to the top
of the end bay, ie X=7.5,
Y=3.5, Z=0.0

Set the grid to 3 bays @
1.5m along the X axis.
Starting at the origin click
anti-clockwise on the grid
to form a plate 1.0m x
1.5m.

The last joint on the plate
becomes the first joint on { -
the next plate so that only { -
three other joints need to | /7 = -
be defined. Again click { .
anti-clockwise to define a >
second and third plate {
along the lean-to main
beam. Once the three |
plates have been created, |
close the Snap Node/Plate 4=k
dialog.

To fill in the rest of the roof plane, select the plates using the Plates Cursor. Select the
Generate Repeat from the toolbar or Geometry menu and set the direction to the Z axis and 25
steps of 1.0m. Note that the Link Steps option should not be selected.

Note that where the generated plates have introduced joints along beam lines, beams will be
split and new beams will be formed with the section and material properties of the original
provided the tolerance is set to Test for added node breaking a beam.

4) Assigning Plate Properties

Plate properties are determined by the thickness and material properties which can be
specified in the Properties sub-page. On the Properties dialog, click on the Thickness...
button and specify a thickness of 0.25m. Note that plates can be specified with varying
thickness', but if only the node 1 value is specified, then a uniform thickness is assumed.
Select the plate property, select the 'Assign to View' option and click on the Assign button.
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5) Creating Views

When working with larger models, it is possible that only a part of the structure is required.
These can be defined as views. To create a view, select the part of the structure that is
required and from the View menv, select the New View option.

To create the view as above, click on Plan View. Change the selection cursor to the
Geometry Cursor so that both the beams and plates can get selected. Select the middle bay
and select New View from the View menu. Select the option 'Create a new window for the
view' and click OK. Note that a Whole Structure window will highlight beams of the current
view as shown above.

The View Management, in the View menu, allows views to be named by selecting the Save
View option and entering a name. With the new view (currently named as <Untitled 1>) as
the current window, select the Save View and name it as 'Middle Bay'.

As the current view is used for the structure when pages are entered, ensure that the Whole
Structure view is the active window when changing to the next page. If the Whole Structure
view is closed it can be re-opened at any time from the View menu.

6) User Analysis Results Tables

It is possible to create results tables by selecting groups of joints, beams or plates which can
be saved away and included in a User Report.

Perform an analysis as in Example 1, change to the Post Processing mode and select the Dead
loadcase to display in the results tables.

Using the Joints cursor, select a number of joints by dragging a window across the structure or
holding down the Ctrl key and clicking on a number of joints. From the Report menu select
Joint Displacements. Select the sort method to Absolute Displacement. Change to the
Report tab, select Save Report and in the Id box, enter the name TFirst set of node
displacements’. Click OK.

The table is now displayed on screen. Open the Report Setup dialog, and note that as the table
was Saved, the table has been added to the user report. Close and view the report with Print
Preview.
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7) Plate Element Contour Maps

Note that the Plate Page has been activated by the presence of plate elements.

From tlie View menu, select the Options item. Change to the Force Units tab and set the
Stress to display N/mm?’.

Change to the Plate Page. Select the Maximum Absolute stress type and click on OK.

8) Animations

Both displacements and contour maps can be animated.

To animate the displacements, change to the Azimation Page. Select Section Displacement,
set Target FPS (frames per second) to 10 and press OK. Press Esc on the keyboard to stop
the animation. The second displacement option Deflection, animates the deflection of the
joints only rather without including the curvature in the beams.

To animate the stress contours, select Structure Diagrams from the View menu. On Plate
Stress Contour tab select Max Absolute stress type. Go to the Animation tab and select
Stress and click on OK.

Press Esc to stop.
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PRV

9) Steel Design

STAAD.Pro can perform a steel design on the analysis results of beam elements and concrete

design on the results of beam and plate elements. The scope of design to be carried out are set
as parameters in the Design page.

Change back to Modelling Mode. -
Go to the Design Page. In the Steel |3
Design dialog Select BS5950. Click on
the Select Parameters button and remove
all the parameters except the Beam and
Track parameters and click OK.

Holding the Ctrl key, select the beams that |
form the near portal frame.

Click on the Define Parameters button, set the : Steel Design - Whole Stucture

Beam parameter, which sets what moment values s !
should be used in the steel design, to 1.0 and press
Add. This includes the parameter but does not
define which beams it applies to.
Click on the Track tab, which sets the level of detail
the design should produce in the output file, and set
the parameter to 2.0 and press Assign. This includes
the parzmeter and also defines which beams it
applies to.

Note that a parameter block has been added with the
code set to BS5950. The Beam parameter has a
question mark to show that it has not been assigned
and needs to be before it will get added to the file.
To assign the Beam parameter, remove the Highlight
Assigned Geometry option, and click on the Beam 1
Jabel to highlight it. The Assign button becomes
available with the Assignment method set to Assign
To Selected Beams. Click on the Assign button to
assign the parameter.

Once all the parameters have been set, the command to perform the code check needs to be
set. With the frame still selected, click on Commands... button and press Assign (or Add

and Assign to Selected Beams as per the Beam parameter).

A steel design has now been setup.
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10) Design Results

Start analysis from Analyze menu. This time it is important to check the current Design Code
setting. Click on the STAAD Design Code tab and ensure the current design code is set to
BRITISH, then click on the Run Analysis button.

| Select Analysis Engine
| AL I,

TP FASRANTE . ™ |

Note that design codes are optional extras, please check you have purchased a design code
before trying to use it.

There are 3 ways to view the design results.
1. Firstly the View Output file. Click on the STAAD Output
page 6 onwards.

_ ning.std -Beam
2. Secondly, using the member 2

query by double clicking on
one of the beams. When a
member has been designed it
has a Steel Design tab such
as the one shown.

3. The third method is to display a Design Results table. Change to Post Processing mode,
change to the Beam Results page and Failure sub-page. The structure diagram is colour
coded and those beams that have been désigned are labelled with their maximum design
ratio.

This concludes the exercise Example 2.

STAAD Pro Training 1.6.sg.doc page -23 of 59




&

B

i

I

fw..,...s.,,a ki

P

r.»..._.u_q

i o

STAAD.Pro:- STAAD Training

8. Example 3 — Using Cut and Paste and User Tables

This example shows some of the more advanced features available with STAAD.Pro.

This structure is based on two back te back parabolic arches.

A

L, M

Front Elevation Isometric

Clearly the structural geometry can be defined using simple mathematical equations and thus
we can utilise the power of a spreadsheet to calculate the co-ordinates for us.

1) Joints - Spreadsheet Input.
The vertical co-ordinates for each node on one arch is defined by the following equation:-

Y =5-(X-5)7x%525)
and tha larera] offser:-
Z=3-((X-3)x325)

With these simple equations added into the spreadsheet, and dragging them for a range of
values for X of 0 1 10 in | meter steps, all the co-ordinates for one arch will be created thus.

-1 X Y Z
2 "1-10" |"5-((A2-5)*2*5/25)" |"3-((A2-5)"2*3/25)"
-3 0 0 0
4 1 1.8 1.08
‘5 2 3.2 1.92
6 3 4.2 2.52
7 4 4.8 2.88
8 - 5 5 3
9 | 6 4.8 2.88
10 7 4.2 2.52
11 8 3.2 1.92
12 9 1.8 1.08
13 10 0 0
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These values can now be highlighted and ‘copied’ to the clipboard using either the ‘Copy’
option from the ‘Edit’ menu or pressing the ‘Ctrl and C’ keys. They are now ready to insert
into STAAD.Pro.. Launch the program, if it is not already running, start a new structure and
go to the Geometry page. Close down the ‘Snap node/beam’ dialogue box and make the
Nodes table the current window. Go to the ‘Edit’ menu and this time select ‘Paste’. The
values have been inserted into the table and show on the diagram. Note that the nodes are
automatically numbered from the point you selected in the table.

2) Add Beams

Make the structure diagram current by clicking inside the window. From the Geometry
toolbar, click on the Add Beams button. Note that the cursor has changed shape when in the
structure window to show that it is in this mode. Click on the first joint, then the second to
form a beam between the two. Click on the second joint, then the third to create a beam
between these two joints. Repeat this to create all the beams.

3) Generate - Mirror.
To form the other half of the structure is simply a case of selecting those beams that are to be
mirrored and clicking on the Mirror E button.
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In this case select all the beams using a window or holding the control key and click on all the
beams. Click on the Mirror button. The plane of the mirror is the X-Y plane with an offset
of 3m. Also ensure that the Copy option is toggled rather than Move. Finally press ‘OK’.

If the final structure does not appear correct, remember that you can generally ‘Undo’ your
last operation. This can be done from the ‘Edit’ menu.

4) Cut/Copy and Paste Elements

The structure can be repeated by using ‘Cut/ Copy and Paste’.
Once again make sure all the elements are selected, but this time select py from the ‘Edit’
menu. Once again go to the ‘Edit’ menu, this time select Paste Eleménts. This presents a

dialogue box which can define an offset from the original location, or graphically using a
reference point.

Press the Reference Point button and an !
image of the structure to be pasted in is
displayed with a highlighted node which
represents the insertion point. Select £
either one of the ends of the frame and
press OK.

The location point on the current
structure needs to be identified, so select 8
the base of the other arch.

This calculates the offset to be 6m in the
Z direction. Click on the OK button to 1
accept the offset. 4

&

D T A A R I R AT | R R AN S N TR

There is a warning regarding the section
properties as none have yet been i .
assigned, this can be ignored. =

é

Finally, use the Add Beam command to draw a beam from the top of the first pair of arches,
to the top of the second pair of arches.

- ~r <o
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5) User Tables

In addition to the standard databases provided within STAAD.Pro, it is possible to create
specialised sections using User Tables which are stored either 'Internally’, within the file, or
'Externally, as a separate file in the same folder as the structure file.

Before creating a User Table, the current input units must be changed to centimetres. Do this
by clicking on the units by clicking on the Input Units b , .

Set the length units to centimetres and click on OK. | A
Select Create User Table... from the Tools menu. Select a Wide Flange as the section type.
In the resulting dialog box, click on the Add New Property button:

In the following dialog box, enter the dimensional values as shown:-

Name: 127x76x13UB Wi
Ax=16.54,ne med -

D=127 ¢t Y

Tw=04
WwWf=17.6
Tf=0.76

T

R R

Click on the Calculate button for STAAD Pro to calculate the sectional properties based on
the supplied dimensions. Note that any of these values can be modified for example to reduce
the cross sectional area. Click on OK to complete the definition of the section. Click the
Close button to complete the User table.

To assign this section to the structure, go to the General page and in the Property sub-page
click on the User Table... button on the Property dialog box, select the property azd click on
the Add button. Notice that as with Standard Databases, a material can be associated with this
section. Finally to assign the section to the structure, click on the propers. s2lect e Assign
to View option and click on the Assign button.

6) Add 1.5m x 2.0m Foundation Supports

Go to the Supports sub-page and change to the Fourdzzoz 120, There are two types of
foundation support that can be created. Footing. which allows pad foundanons of a specified
size to be created and an Elastic Mat option whers STAAD will esizdlish a zone around
depending on the spacing and locatior. of surrounding nodes. Both commands create a spring
support depending on the sub-grade suffness.
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A sub-grade stiffness 10 kN/m”/ m means that a load of 10 kN over a plan area of Im? will
settle 1m such as in the following example.

Cieate Suppoit

i

Note that this is analytically identical to creating the command:-
FIXED BUT KFY 10

Enter the values shown in the dialog box and click on the C}ée button. Assign the support
to the base of all the arches.

7) Multiple Loadcase and Combinations
The first two Examples used structures that only had one loadcase each. STAAD.Pro can

analyse structures with many individual loadcases and combine them together with various
multiplication factors.

‘ First the basic loadcases must be defined.

Go to the Loads sub-page, create loadcase 1 and name it Dead Loads.

Click on the Selfweight... burton and create the selfweight loadcase with a factor of -1 in the
Y direction. -

Add a UDL of I kN/m on all the beams by clicking on the Member... button. In the Uniform
Force tab, enter the value of -1 for W1 and click on the Add button. Select the Assign to
View method and click on the Assign button.

To create the second loadcase, select the menu item Commands|Loading|Create New

Primary Load... , select the option to Create a New Primary Load Case and name it Live
Load. 4

Click on the Member... button. On the Uniform Force tab enter the values -15 for W1, 1 for

dl and 2 for d2. Click on the Add button and Assign it to the beam that spans between the
two pairs of trusses.
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Create the third loadcase as above by selecting the menu ittem Commands|Leading|Create
New Primary Load... , select the option to Create a New Primary Load Case and name it
Wind Load. . T

Click on the Nodal... button. On the Node tab enter the value 5 kN in the FX field and click
on Add. Select the two joints (not the beam itself) at the ends of the beam that spans between
the pairs of trusses and Assign it to those joints.

Now these loadcases can be combined into combinations.

Select the menu item Commands|Loading[Load Combinations... In the dialog box click on
the New button, type the title of the combination as Dead + Live and click OK to create the
combination.

To include the dead loadcase in this combination, set a factor of 1.4, select Dead from the
available list and click on the > button.
Repeat this with the Live loadcase with a factor of 1.6.

Deline Combinations

1{1.400000) DEAD LOADS
+ E000I LVE LIADIS

Create a second combination by clicking on the New button and enter a title of Dead + Live +
Wind. This time set the load factor to 1.2 and click on the >> button to include all the
loadcases in the combination.

As before the structure needs the command to instruct the analysis to proceed. Select the
menu item Commands|Analysis|Perform Analysis... and click on the OK button to accept
the command with the 'No Print' option.

Te

Run the analysis to produce a set of analysis resul:s.
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8) Analysis Results

Now that the structure has more than one loadcase, it is important to recognise the
fundamental difference between graphical views. That is that whilst the graphical views can
display the results of the analysis, they can only display the results of one loadcase at a time.
Results tables on the other hand can display the results of many loadcases and combinations
simultaneously and establish which are the maximum and minimum values. Therefore, when
entering into the Post Processing mode the loadcases which will be displayed.

LS Loadcase displayed in the current
et structural view
£ Ererh 15 LY w T SRPASE B antd k‘,“?:

AR A

1283 wino Loa

- e el

28] 5 DEAD + LIVE + WIND
s e
R

=

Loadcase displayed in the results
tables.

£

B

A S R s N A
s = e

P

Click on the Post Processing mode and select all the loadcases in the Results Setup dialog as
above and click OK.

To change the loadcases that are displayed in the results tables either right click over the table

and select Results Setup from the POp-up menu or it can be selected from the main menu
Results|Results Setup.

This concludes the exercise Example 3.
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9. Example 4 — Structure Wizard and Dynamic Analysis
This example looks at other features within STAAD.Pro.

1) Structure Wizard

Yet another form of generating structural geometry is the Structure Wizard. Start a new
structure, click on the Geometry menu and select the Run Structure Wizard option. This
launches the Structure Wizard.

Select Frame E
models and
double click the
Bay Frame and
set the
parameters  as | ' '
shown and click a.??im. Gﬁd@m Fsﬁm
e Apply.
L — = 8
* To transfer the || Spmess  Ofinticsl Rowme
model into the
f (e STAADPro

R structure, click Select Parameters
(W on the Transfer
Model button.
Locate the |
model without a
shift from the
origin. :

oo vawms

We wish to replace the four top beams with Tusses. Highlight them iz the sTucture view and
click on the Del key.

. -
T 2+ t3e QT 7

T vz S — daty

Once again Start the
Structure Wizard.

This time select a and
generate a  Howe
Bridge Frame with
the dimensions as
shown. Transfer it to
STAAD.Pro as before, s < s
but this time locate this
model 3m above the
origin, i.e at the top of
the columns. Note that

Select Parameters

ModatNamg: THowe Bacce
Lenghﬁ o NG T oes mong each: -

Haight i1.5 m

where beams would be . ~rmagee T
duplicated, they have — 1
not been created. ! - ——

Ready Input Unit: ‘'m
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2) Add Properties and Supports

Add the section properties as in Example 1 and 2. Go to the General page (Property sub-
page), add the British section UB305x102x33 and assign it to the columns, first floor and
eaves beams. Then add the British section UA100x75x$ aid assign it to all the remaining
roof beams. ’

Go to the Supports sub-page and add a PINNED support. Assign the support to the base of
all the columns.

Right click on the Whole Structure window and select the Structure Diagrams... option
from the popup menu. On 3D sections, set the option to Full Sections. The diagram should
look thus:-
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10. Example 5 - Multiple Analysis

During a single analysis run, STAAD.Pro can modify the structure (therefore the stiffness
matrix) and perform multiple analysis calculations. This is needed in situations such as when
beams are defined as tension members and thus each loadcase needs to analysed separately as
beams may be removed under some load conditions, but not others. In such situations
additional commands are required:-

SET NL Required to let STAAD know how much space will be required for analysis.
CHANGE  To reset the stiffness matrix for the next analysis.

'Use the Example 3 model which has 2 loadcases and 2 comvbinations already defined.
Open the file and SaveAs... Example 5.

1) Defining Beams as Tension Only

Go to the General page and the Spec sub-page.

With the beams cursor, select the cross beam that joins the pairs of arches together. Click on
the Beam... button and select the Tension tab. Click on the Assign button to define the
selected beam as a tension only beam.

2) Modify the Loading

Recall that this structure currently has 3 basic loadcases (numbers 1, 2 and 3) and 2
combination loadcases (numbers 4 and 5). Combination numbers must follow all basic
loadcase numbers. To add an additional loadcase, the current combination numbers need to
be revised.

Firstly go to the Load sub-page and display the 1% loadcase. Select the menu item
Commands|Loading|Load Combinations... and display load combination 4. Remove the
combination by clicking on the Delete button. Click OK to close the Combinations dialog.

To add a new basic loadcase, click on the menu item
Commands|Loading|Create New Primary Load..., select the Create option set the loadcase
number to 4 and name it Side Wind and click on the OK button.

Create a 10 kN Nodal load and 10 kN
assign it to node 6 so the structure
should look like this:-
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3) Add Muitiple Perform Analysis Commands
As discussed at the start of this example, multiple analysis commands have to be added and

the number of loadcases.

Firstly, set the number of loadcases, select the menu item
Commands|Miscellaneous|Set NL...., set the number to 4 and click OK.

Next, the commands to perform each analysis need to be added. To do this, go to the

Analysis/Print page and the Analysis sub-page.
On the Analysis Tree control window, click on Load 1Dead Loads to make it the current

selection and click on the Define Commands... button.
Select the option to add the command After Current so that it is shown with a tick. Then,
whilst on the Perform Analysis tab, click on the Add button.

. Analysis - Whole Structure E3:
-3 START USER TABLE ei
73 MEMBER PROPERTY BRITIS
- CONSTANTS
B3 SUFFCRTS
W MEMBER TENZION
83 LoAD 1 DEAD LOADS
X SELRWEIGHT Y 9
= 83 HMEMPER LOAD
Lo UGy 28
- PERFORM ANALYSIS
DD DUYELOSD

Perform Analysis command has
been added after Load 1

Now select the command PERFORM ANALY SIS command in the tree control window and
again click on the Define Commands... button. Select the Change tab, again ensure that the
After Current option is set and click on the Add button.

Repeat the above two steps of adding the PERFORM ANALYSIS and CHANGE
commands to follow loadcases 2 and 3. Then after the last PERFORM ANALYSIS that was

defined from Example 3, add a CHANGE command.
Finally run the analysis, change to Post Processing Mode. Select the results of Loadcase 4
only. Change to the Beam page and note the forces on the beam between the frames that was

defined as TENSION only is all zero as the applied load has forced it into compression.

This concludes the exercise Example 5.
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11. Example 6 — RC Beam, Column and Slab Design

There are two methods to design beams, columns and slabs in STAAD.Pro. The original
STAAD method involves including a number of parameters in the input file after the
PERFORM ANALYSIS commands so that when the analysis is run a design is also
performed. This gives a fixed set of design results and requires the whole analysis to be re-
performed if there are tweaks required in the design. The second newer and more favoured
method utilises the analysis results in the graphical interface allowing greater Interactivity with
the design and is described in the following example.

Desigi members are formed from the analytical beam elements =nd can be used to design
beam and / or columns for a range of design codes. Also shell elements can be designed as
slabs.

Note that slab designs are performed using the finite elements. The local MX and MY
moments are resolved into the global axes and the reinforcement requirement calculated on
those forces alone. Note that there is no check for shear. Also no account is taken for the
torsional MXY moments.

1) Create Beam and Columns
Start a new structure based on kNs and metres.
Use the Structure Wizard and create the 3D frame in Example 4 (without the roof trusses).

2) Create First Floor Slab
Return to the Structure Wizard and create a Surface, Quadrilateral with the following
parameters:-

L XY 4 . 1 Bias | Divn.
A 0 0 0 AB |1 6
B |6 0 0 BC ] 6
C 6 0 6 CD ] 6
D0 0 6 DA ] 6

Click on the Transfer Model icon to iccorporate the slab into the model. To raise the slab to
first floor level, enter a value of 1.5m when prompted in the Paste Prototype Model dialog
box. You can altemnatively do the same using the mesh generator cursor available in the select
menu and by clicking on the corner points for the mesh in the GUI itself.

3) Define Section Properties and Supports

Change to the General page and in the Property sub-page click on the Define... button to
create the cross sections.

For the columns, create a circle with a diameter YD: of 0.35m. Note that the materia]
property associated with this section is concrete as defired in the INI file and displayed in the
materials table. Assign the section to all the columns.

For the beams, create a rectangle with a depth (YD) of 0.40m aad width (ZD) of 0.25m.

For the slab, define a plate property thickness of 0.175m made of concrete.

Go to the Support sub-page, create a fixed support and assign it to the base of all the
columns.
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In the Structure Diagrams dialogbox;~. . A~ 7 N
i) Set 3D sections to Full Sections? ©~ =&t T < 7T
ii) Set View Fill Plates / Solids.

1i1) Set sort geometry and,

v) Set sort Nodes.

the structure should appear thus:-

2 5t - Wholo Stnuctue__

4) Floor Loading

Go to the Load sub-page and create the first loadcase naming it Dead.

Click on the Selfweight... button and create a selfweight load in Y with a factor of -1.

Click on the Member... button and select the Floor with Y range' tab. Set the load to
-3.5 kKN/m?, the Y range maximum to 3 m (ie both floors), X range maximum to 6m and Z
range maximum also to 6m. Click on the Add button to apply.

Note that this command is similar to the Selfweight command in that it contains all the
information needed in itself and does not need to be assigned to the structure. Also this
command only applies loads to the beams, not the plates.

Add an area load of 10 kN/m? to the plates. Click on the Plate... button and on the Pressure’
tab, set a load of 10 kN/m? in the Local z direction. Note that the local z axis on these plates
points downwards, hence the load is on the top acting down.
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From the menu item Commands|Loading|Create New Primary Load..., create a second
loadcase and name it Live 1.

Click on the Member... button and select the "Floor with Y range' tab. Set the load to
-15.0 kN/m?, the Y range maximum to 3 m (ie both floors), X range maximum to 6m and Z
range maximum also to 2m. Click on the Add button to apply.

From the menu item Commands|Loading|Create New Primary Load..., create a third
loadcase and name it Live 2.

Click on the Member... button and select the Floor with Y range' tab. Set the load to
-20.0 kN/m?, the Y range maximu:m to 3 m (ie both floors), X range maximum to 6m and Z .
range minimum to 2m and maximum to 4m. Click on the Add button to apply.

From the menu item Commands|Loading|Create New Primary Load..., create a forth
loadcase and name it Additional Live.

Click on the Nodal... button and Add an FY joint load of -150 kN. Assign this load to the
first floor level of the columns on the left of the structure after clicking on the Isometric View
button.

Create a combination from the menu item Commands|Loading|Load Combination..., click
on the New button and name the combination ULS. Set the load factors at 1.4 for the Dead
loadcase and 1.6 for all the others.

Finally add the Perform Analysis command as before and run the analysis.

5) Slab Design

Change to the Post Processing mode.

Make the graphical view full screen. Select the menu option Results|Slab Reinforcement...
The dialog allows slab reinforcement design parameters to be set.

First set the loadcases that are to be designed by changing to the "Loading' tab and selecting
the loadcase 'S ULS'. Select the view of ‘Bottom' reinforcement with an Enhanced' contour to

get the following :-
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6) STAAD.Pro RC Design (Beam and Column design)
To start the RC Designer, select the menu option File|Run StaadPre RC Design. This starts
another application and loads it with the current structure and analysis results.

There are 5 steps to then perform a concrete design.
1. Create envelope

Beams are designed USING i arincat i bnan—
. k Define Envelopes. . [
envelopes of the analysis forces. N prataeT na e ShRIE I
Click on the Envelopes page.
On the Envelopes table click on
the New Env... button to open N ALLVE
the Envelope dialog box. g
Type a name for the envelope
and click OK to open the
following dialog box:-
To view all the loadcases as well
as combinations, click on the
Show  Combinations Only
option so that it is not selected.
Include all the loadcases in the envelope by clicking on the >> button and click OK.

2. Create members

Design is performed on Members, formed from one or more beam elements that can be
joined together. There are two methods of forming Members, Form Member or AutoForm
Member. The first attempts to join all the selected elements into a single beam, the second
uses internal algorithms to identify continuous beams and separates others beam elements into
other members.

First select the nearest long span beam at first
floor and click on the Form Member @
button.

Then select the elements that span along the !
short side at first floor level and click on the |
Form Member button. This should produce
the following two members:-
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Then select all the beam elements that form the
columns under member M2 and click on the (

AutoForm Member % button.

This will create 4 new members, M3 to M6, !
thus:- |

3. Create Design Briefs
The design is then carried out to a set of parameters that are defined in a Design Brief. A
Design Brief is then used by a group of members known as a Design Group.

Go to the Groups/Briefs page. Check the Design Briefs table and ensure that the code is set
to BS8110 Beam. Select it from the pulldown list if it is not currently selected. Click on the
text 'Design Brief 1' and rename it by entering the text 'BS8110 beam brief. Click on the Edit
Brief button to view the parameters. Change the concrete grade to C30 and click OK to
accept this change and the rest of the default parameters.

Create a second design brief for designing columns. Click on the New Brief button, select
BS8110 Column and name it 'BS8110 Column Brief' Click on the Edit Brief button and from
the Member Combs tab, select the combination ULS. Click OK to accept this change and the
rest of the default parameters.

4. Create Design Groups ,

A Design Group, as mentioned above, are members selected from the graphical window and
associating them with a Design Brief. Note that a member can exist in more than one design
group.

Select the beam members M1 and M2 and click on the New Design Grp button. In the dialog
box, name the design group ‘Beams’, ensure that the BS8110 Beam brief defined above has
been selected and click OK.

Select the column members M3, M4, M5 and M6 and again click on the New Design Grp
button. Name the group ‘Columns' and select the second design brief BS8110 Column Brief.

5. Design the Group
All that remains is to perform the design. Firstly, designing the beams.

From the pulldown list of Design Groups select G1:Beams. Change to the Concrete Design
Mode by selecting it from the Mode menu or from the mode button on the page control. As
with STAAD.Pro - STAAD, changing mode changes the pages on the page control. The
pages and the layout of the pages is determined by the design code associated with the current
design group. With this BS8110 Beam design there are seven pages and is entered on the
Summary page. To design the group, click on the Design page which shows the Design
Options dialog box. We wish to design both members of the design group, therefore click on
the Design button.
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Both members are shown in green to indicate that they were designed successfully, as is
confirmed in the Summary table. Click on the Main Layout page to view the result of the
design. :

taad/Pro RC - En.gmp e

The Main Reinforcement diagram shows the layout of the reinforcement above a capacity
graph which is in rz above a cross section of the beam. To move the location of the cross
section, either tvpe in a distance in the section edit box and click on the set button or click and
drag the cross section arrows. Also note that proportions of the windows can be resized by
clicking and dragging the horizontal separation bars.

In the whole structure window, click on the member m2 to view the designed layout on that
member. Alternatively select M2 from the pulldown list in the toolbar.

To view the details of the design, select the menu option File|BS8110 Report setup...
Remove all the selected items from the report, add the item Design Detail and click OK. To
view the report, click on the Print Preview button.

Next to design the columns, select the design group G2: Columns from the pulldown list in
the toolbar.

Perform the design as for the beams by clicking on the Design page and click Design on the
Design Options dialog box. Change to the Main Layout page to view the resulting
reinforcement layout.
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laalo RC - Exampl ‘
£ W # i

Mz(kRm)
80 40 > 40 80

[TRSENNE S TENTN

487 15

-25.6
BARAE 35 LARAREA)
7

80 40

17 40 80

This concludes the exercise Example 6
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12. Detailed Steel Design Example to BS 5950: Part 1:1990

There are a number of example calculations produced by the Steel Construction Institute in
their publication Steelwork Design Guide to BS 5950: Part 1:1990 Volume 2 Worked
Examples (Revised Edition). The following examples demonstrate how those aspects which
are within the scope of the STAAD.Pro can be implemented.

Example 1, Simply supported beam with full lateral restraint.
The first stage is to define the model (steps 1-8). Then check the section for forces (steps 9-
14). Finally check for deflection (steps 15 to 21).

This is the model:-
UB533X210X392 UBS33X210X92
3250.00mm 3250.00mm
1. Starta new 'Space’ file with the default SI units of ‘Metres’ and KiloNewtons',

2. Change to the Geometry Page, Beam sub page, change the grid so that the X spacing is

3.250m. Generate the two segments of the 6.5m beam.

Change to the General Page, Property sub page, select a 533x2/0x92 UB section and

assign it to both beam segments.

4. Change to the Supports sub page. The supports need to be pinned about the global Z axis
(not fully pinned as this will cause an instability about the global (and local) X axis.
Therefore create a Fixed But support where it is released about the MZ axis. Assign this
support to either end of the model.

5. Change to the Loads sub page and create the first loadcase, ‘Dead’. Create the loads UDL
-15 KN/m assigned to both beams and the point load -40 kN and assign it to the central
node.

6. Create the second loadcase, ‘Live’. Assign the UDL loads of -30 kN/m to both the beam
segments and the point load of -50 kN to the central node.

7. Create a load combination by clicking on the 'Combine...' button. On the Combination
dialog, click on the New button and name the combination ‘ULS". Include loadcase 1,

‘Dead’ with a factor of 1.4 and loadcase 2 ‘Live’ with a factor 1.6.
Dedne naten wans [x]

(93]

8. Changev- tc; the | Analysis/Print page, Analyéis sub page. Add the command
PERFORM ANALYSIS PRINT STATICS CHECK
and run the analysis.

Check your analysis results and confirm that your statics check in the output file indicates that
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) SUM-Y for loadcase 1 is 137.5 kN
1) SUM-Y for loadcase 2 is 245.0 kN.

Also confirm by whichever method you prefer that the maximum moment in the combination
is 585 kNm.

Now to check the section to BS 5950. The first check will be for the forces, the second will
be for deflection. The section is defined as having it's compression flange as fully restrained.
This means that for the lateral torsional buckling check, the effective length is zero.

9.

10.

11.

12.

13.

14.

In the Modelling Mode, change to the Design page, Steel sub-page. On the dialog box,
change the code to BS5950. Click on the Select Parameters, remove all the parameters
from the selected list except for BEAM, TRACK and UNL.

Create a BEAM parameter of 2.0 and assign it to both beams. The BEAM parameter is
used to define the locations where forces should be checked and calculations should be
performed on a beam. The default value is 0.0 which means that the beams are designed
using the forces at either end and the maximum result is reported. If there are forces
applied along the length of a beam, then it is advised that a BEAM 1.0, 2.0 or 3.0 is used.
Create a TRACK 2.0 command and assign it to both beams. This will generate a more
detailed report in the output file which can be checked.

Create a UNL 0.0 command and assign it to both beams. As stated above, the beam is
restrained against lateral torsional buckling and thus it's effective length in buckling is
ZEeTo.

Click on the Commands... button and create a Check Code command and assign it to
both beams. This is the instruction to perform the design.

redd leon - Wik fractur. 3

The Steel Design dialog should now
look similar to this:-

Note that there are only ticks in the
parameter section. If there are any 7'
next to the parameters, then the program
is indicating that commands have been
defined, but not assigned to any
members.

Save the file and re-run the analysis. With design parameters included, it is important that
when running the analysis the correct design code is selected from the analysis dialog box.
Ensure that it is set to BRITISH and not BRITISH(EXTENDED) as this is for BS 8007
and BS 5400.
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Check the output file for the pages of the code check and you should have the following.

Note in particular the highlighted items:-

STAAD-III CODE CHECKING - (BSI )

L2 A R RS SRS RSS2 R

PROGRAM CODE REVISION V3.3_5950_90/2

STAAD SPACE -~ PAGE NO.

ALL UNITS ARE - KN METE (UNLESS OTHERWISE NOTED)

MEMBER TABLE RESULT/ CRITICAL COND/ RATIO/ LOADING /
rx MY MZ LOCATION

MATERIAL DATA

Grade of steel = 43
Modulus of elasticity = 205 kN/mm2
Design Strength (py) = 275 N/mn2 Reduced = 275N/mm2
SECTION PROPERTIES (units - cm)
Member Length = 325.00
Gross Area = 117.00 Net Area = 117.00
z-axis y-axis
55229.996 2389.000
2360.000 356.000
2072.031 228.285
58.770 53.843
z21.727 4.519
325.070 325.000

Sguasnh Lcad
Axial fzrce Squash load

4

Slenderness ratio (KL 1}
Compression Capacity

¥

Tension Capacity : kM

Moment Capacity £45
Reduced Moment Capacity £43.°2
Shear Capacity 33,7

BUCKLING CALCULATIONS (units - kN,m)
Lateral Torsional Buckling Moment = = £4% 0 B
co-efficients m& n : m =1.00 n =1.03, Bffective Length= 000D

CRITICAL LOADS FOR EACH CLAUSE CHECK (units- &N.=x :

CLAUSE RATIO LOAD FX vY e Y2 MY
BS-4.8.3.2 0.814 3 0.0 292.2 ¢.° £85.4 0.0
BS-4.8.3.3.2 0.902 3 0.0 292.2 o 585.4 0.0
BS-4.2.3-(Y) 0.329 3 0.0 292.2 o, 6.0 0.0
B5-4.3 / 4.9 0.902 3 0.0 292.2 Ll $85.4 0.0
STAAD SPACE -- PAGE NO. 6

Torsion and deflections have not been considered in the design.

The final stage is to perform the deflection checks.
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15.

16.

17.

18.

19.

20.
21.

In the Modelling Mode, changé to the Analysis page, Post Print sub-page. Click on the

units icon EZ2 and select ‘millimetres’. Click on the Define Commands... button and on
the Load List option, move the Live loadcase from the left to the right selection iist. Click
on the Add button, then close the dialog box. Note that both the unit command and the
load list command are now displayed in the dialog box.

Click on the Design page, Steel sub-page. The code will already be set to BS5950. Click
on the Select Parameters button and select DFF, DJ1, DJ2 and TRACK.

Select both beams and create a TRACK 4 command. As both beams are selected the
Assign option should be available on the Design Parameters dialog box. Click on this
button to both crcate the command and assign it to those beams. Note inat a new
parameter section has been started in the file.

With the beams still selected, create and assign DJ1 as node 1 and DJ2 as node 3, which
defines the extent of the beam which should be checked for the local deflection.

Create and assign the command DFF with a value of 360 as the problem states that the
beam is assumed to carry a plaster finish.

Click on the Commands... button, create and assign Check Code.

Finally save the file and re-run the analysis. The final page of the output file should be
similar to this. Again take note of the highlighted values:-

CLAUSE BS-2.5.1 CHECKS

LENGTH UNITS - MMS

MEMBER TABLE RESULT ACTUAL DEFL. DEFL.LEN/ LOAD/
DEFL. LIMIT DFF LOCATION
1 ST UBS33X210X92  PASS 97228 187056 6500.000 2
' ' 360.000 3250.00
2 ST UB533X210X92  PASS 9.228  18.056 6500.000 2
360.000 0.00

swvxwxwrxrkxxrrx END OF TABULATED RESULT OF DESIGN ***k s sssxsdhdn

Note that there is a slight difference in the calculated deflection of 9.2mm (value in
publication 8.66mm) is due to the I value differing between that used by STAAD of
55229¢m”* and 55400cm’* used in the publication.
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Example 2, Simply supported beam with restraint at load points.
Create the model below using steps 1-8 in example 1.

: LBl LBETXaeR LBEXONR
@ 3am 3m 30m
Load Data:-
Loadcase 1:-
UDL, -3 kN/m (GY)on all three beams.
Point loads  -40 kN (FY) on joint 2
-20 kN (FY) on joint 3
Loadcase 2:-
Pointloads  -60 kN (FY) on joint 2
-30 kN (FY) on joint 3

Load Combination 3:-
1.4 x Loadcase 1 + 1.6 x Loadcase 2

The bending moment should appear thus:-

"l : !
| : i
) i )

\

|

Mak -342 kNm
\, : i i !
\ Mak: -{18 kNu;!
|
: g
: //*“/
Iﬁ( //L/
/—"
and the shear force:-
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SERNEEENENRERYN

Max: -120 kb

L

The structure is now ready to be designed.

There are essentially three checks that are carried out in this example,
D Shear load / shear capacity, (the maximum shear force is at the start of beam 1).
J1§) Maximum moment / moment capacity, (the maximum moment is at the end of
beam 1 or the start of beam 2).
)  Equivalent moment / lateral torsional buckling capacity, (the critical section is
between the two intermediate restraints, ie beam 2).

Therefore we need to set the following parameters:-
TRACK as 2.0 to get a detailed output
CMM to -1.0 to calculate 'm' for the major axis (otherwise it uses the default of 1.0).
CHECK CODE members 1 and 2.

Define the parameters as outlined in the previous example steps 9 to 14 and run the analysis.
The last pages of the output file should be as follows:-

34. PARAMETER
35. CODE BS5950
36. MM -1 ALL
37. TRACK 2 ALL
38. CHECK CODE MEMB 1 2

Check your parameters to ensure the correct parameters are being used.
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STAAD-III CODE CHECKING - (BSI )

KRNI AR AR A AR I AR TR X IRF I N

PROGRAM CODE REVISION V3.3_.5950_90/2

STRAD SPACE -- PAGE NO.
ALL UNITS ARE - KN METE (UNLESS OTHERWISE NOTED)
MEMBER TABLE RESULT/ CRITICAL COND/ RATIO/ LOADING/
FX ny w2 LOCATION
-
3 ST UB457X191X82 PASS BS-4.8.3.2 0.688 3
0.00 0.00 417.80 3.00
MATERIAL DATA
Grade of steel = 43
Modulus of elasticity = 205 kN/mm2
Design Strength (py) = 275 N/mm2 Reduced = 275N/mm2
SECTION PROPERTIES (units - cm)
Member Length = 300.00
Gross Area = 104.00 Net Area 104.00
z-axis y~axis
Moment of inertia : 37050.000 1871.000
Plastic modulus : 1831.000 304.000
Elastic modulus : 1610.869 195.609
Shear Area : 55.083 45.540
Radius of gyration : 18.875 4.242
Effective Length : 300.000 300.000
DESIGN DATA (units - kN,m) BS5950/1990
Section Class H PLASTIC
Squash Load : 2860.00
Axial force/Sguash lcad : 0.000
z-axis y-axis
Slenderness ratio (KL/r) : 15.9 70.7
Compression Capacity : 2860.0 2084.9
Tension Capacity : 2860.0 2860.0
Moment Capacity : 503.5 64.6
Reduced Moment Capacity : 503.5 64.6
Shear Capacity : 909.1 75104
BUCKLING CALCULATIONS {units - kN, m:
Lateral Torsional Buckling Moo MEZ = I%€.%5
co-efficients m & n : m =0.57 n =1.10. Effeztive Lenzth= 2.00)

CRITICAL LOADS FOR EACH CLAUSE CHECK (units- kN.z

CLAUSE RATIO LOAD FX VY
0.688 3 0.0
0.601 0.0

BS-4.3 /4.9 0.601 3 0.0 -133.0
Torsion and deflections have not been considere

8.0

ir. the design.

[}

Comparing the published results with those in the STAAD design:-
The published moment check shows the capacity as 503 kNm (STAAD design is 503.5 kNm)
The published shear check shows the capacity as 752 kN (STAAD design is 751.4 kN)
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STAAD SPACE -- PAGE NO.
ALL UNITS ARE - KN METE (UNLESS OTHERWISE NOTED)
MEMBER TABLE RESULT/ CRITICAL COND/ RATIO/ LOADING/
FX XY HZ LOCATION
2 sT UB457X191X82 PASS BS-4.3 / 4.9 0.956 3
0.00 0.00 -417.80 0.00
MATERIAL DATA
Grade of steel = 43
Modulus of elasticity = 205 kN/mm2
Design Strength (py) = 275 N/mm2 Reduced = 275N/mm2
SECTION PROPERTIES (units - cm)
Member Length = 300.00
Gross Area = 104.00 Net Area = 104.00
z-axis y-axis
Moment of inertia 37050.000 1871.000
Plastic modulus 1831.000 304.000
Elastic modulus 1610.869 195.609
Shear Area 55.093 45.540
Radius of gyration 18.875 4.242
Effective Length 300.000 300.000
DESIGN DATA (units - kN,m) BS5950/1990
Section Class PLASTIC
Squash Load 2860.00
Axial force/Squash load 0.000
z-axis y-axis
Slenderness ratio (KL/r) 15.9 70.7
Compression Capacity 2860.0 2084.9
Tension Capacity 2860.0 2860.0
Moment Capacity 503.5 64.6
Reduced Moment Capacity 503.5 64.6
Shear Capacity 909.1 751.4
BUCKLING CALCULATIONS (units - kN,m)
Lateral Torsional Buckling Moment
co-efficients m & n : ‘n =1.00, Effective Length= 3.000

CRITICAL LOADS FOR EACH CLAUSE CHECK ({units- kN,m}:

CLAUSE RATIO LOAD FX vY Vi MZ MY
BS-4.8.3.2 0.688 3 0.0 -19.0 0.0 -417.8 0.0
BS-4.8.3.3.2 0.956 3 0.0 -19.0 0.0 -417.8 0.0
BS-4.2.3-(Y) 0.042 3 0.0 31.6 0.0 341.8 0.0
BS-4.3 / 4.9 D956 3 0.0 -19.0 0.0 -417.8 0.0

Torsion and deflections have not been considered in the design.

S22 22 R L L8 2

cwxxxxxxxxxxr* END OF TABULATED RESULT OF DESIGN
319. FINISH

Comparing the published results with those
The published equivalent moment factor m is

The published Buckling resistance moment Mb is 397 kN STAAD des:
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Example 3, Simply supported beam without intermediate restraints.
As example 2, create the model below using steps 1-8 in example 1 or copy the example 2
model without the design parameters and change the section profile to:-

UB610X229X140.

As the beam is not restrained at the joint locations, the effective lengths of the beams need to
be defined for the calculations of Mb in the lateral torsional buckling check. This can be done
either by setting an appropriate factor on each beam using the UNL parameter, or specifying
the effective length directly using the UNF parameter. In this example, the effective length of
the beam is defined as 0.85 x 9.000m = 7.65m. This can be specified by assigning UNL 7.65
to the members or assigning the parameter UNF of 0.85 x 3 =2.55. This can be awkward in
situations where the beam is not made up of equal segments.

Therefore we need to set the following parameters:-
TRACK as 2.0 to get a detailed output
UNL 7.65.
CHECK CODE ALL members.

Define the parameters as outlined in the first example steps 9 to 14 and run the analysis. The
last pages of the output file should be as follows:-

34. PARAMETER
35. CODE BS5950
36. TRACK 2 ALL
37. UNL 7.65 ALL
38. CHECK CODE ALL
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STAAD-III CODE CHECKING - (BSI )

(2SR E R ERE R R ST R

PROGRAM CODE REVISION V3.3_5950_90/2

STAAD SPACE

~~ PAGE NO.

ALL UNITS ARE - KN METE (UNLESS OTHERWISE NOTED)

MEMBER TABLE RESULT/
FX

CRITICAL COND/ RATIO/

MZ

LOADING/
LOCATION

0.00

MATERIAL DATA
Grade of steel
Modulus of elasticity
Design Strength (py)

SECTION PROPERTIES (units -
Member Length = 300.00
Gross Area = 178.00

Moment of inertia
Plastic modulus
Elastic modulus
Shear Area

Radius of gyration
Effective Length

DESIGN DATA (units - kN,m)
Section Class
Squash Load
Axial force/Squash load

Slenderness ratio (KL/r)
Compression Capacity
Tension Capacity

Moment Capacity

Reduced Moment Capacity
Shear Capacity

BUCKLING CALCULATIONS (units - kN, m)
Lateral Torsional Buckling Moment
co-efficients m & n : m =1.00 n =1.00,

0.00 3.00
= 43
= 205 kN/mm2
= 265 N/mm2 Reduced = 265N/mm2
cm)
Net Area = 178.00
z-axis y-axis
111799.992 4505.000
4142.000 611.000
3622.812 391.399
91.571 80.853
25.062 5.031
300.000 300.000
BS5950/1990
PLASTIC
4717.00
0.000
z-axis y-axis
12.0 59.6
4717.0 3814.2
4717.0 4717.0
1097.6 124.5
1097.6 124.5
1456.0 1285.6
MB = @5

Effective Length= 7.650

CRITICAL LOADS FOR EACH CLAUSE CHECK {(units- kN,m}:

CLAUSE RATIO LOAD
BS-4.8.3.2 0.145 3
BS-4.8.3.3.2 0.923 3
BS-4.2.3-({Y) 0.113 3
BS-4.3 / 4.9 0.923 3

a

FX VY
0.0 -133.0
0.0 -133.0
0.0 145.6
0.0 -133.0

vz MZ

0.0 417.8
0.0 417.8
0.0 0.0
0.0 417.8

[ = )
56655

Torsion and deflections have not been considered in the design.

Comparing the published results with those in the STAAD design:-

The published Buckling resistance moment Mb is 450 kNm (STAAD design is 452.6 kNm)
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Example 4, Column with pinned ends and intermediate support.
As with the previous examples, create the model below using steps 1-8 in example 1.

This is a 6m high columr with a lateral restraint at
mid-height.

Provide a support at the base which is 'Fixed But, MX
and MY. At the top provide another support which is
'Fixed But' MX, MY and also FY.

Loading is applied as a single factored point load at
the top of the column of -2500 kN (FY). As the load
has already been factored, then no load combination is

required.

Create the command PERFORM ANALYSIS as with
all the other examples.

Check that there is the correct loading by changing to
the Post Processing Mode and review the reactions.
There should be none at the top and 2500 kN
vertically at the base.

The structure is ready to be designed.

When beams are being designed as columns (ie compression members, clause 4.7), then the
design lengths and factors that are used are defined with the parameters LY and LZ if defining
the actual lengths or KY and KZ if defining a multiplication factor of the actual beam length.
In this example, restraint is provided at mid height when bending about the local Y axis, but
not the local Z axis. Therefore the effective length of both these beams when bending about Z

axis 1s twice their actual length, or 6.0 m.

Therefore we nead 0 set the following parameters to both members:-

TRACK 2.0
LZ6.0
CHECK CODE

)

UC254X254X89

UC254X254X89

\TS“J
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STAAD.Pro:- STAAD T; raining

The resulting design output should for either member should be:-

STAAD-III CODE CHECKING - (BSI )

itx*t'ti!ittt*t***t****

PROGRAM CODE REVISION V3.3_5950_90/2

STAAD SPACE == PAGE NO.
ALL UNITS ARE - KN METE (UNLESS OTHERWISE NOTED)
MEMBER TABLE RESOLT/ CRITICAL conn/ RATIO/ LOADING /
FX MY  +4 LOCATION
-
* 1 ST UC254x254x%89 FAIL BS-4.7 () 1.003
2500.00 ¢ 0.00 0.00 00
MATERIAL DATA
Grade of steel = 43
Modulus of elasticity = 205 kN/mm2
Design Strength (py) = 265 N/mm2 Reduced = 265N/mm2
SECTION PROPERTIES (units - cm)
Member Length = 300.00
Gross Area = 113.00 Net Area = 113.00
z-axis y-axis
Moment of inertia : 14269.999 4857.000
Plastic modulus : 1224.000 575.000
Elastic modulus : 1096.427 379.009
Shear Area : 79.810 26.811
Radius of gyration : 11.238 6.556
Effective Length : 600.000 300.000
DESIGN DATA (units - kN, m) BS5950/1990
Section Class : PLASTIC
Squash Load : 2994.50
Axial force/Squash load 0.835
y-axis
Slenderness ratio (KL/r)
Compression Capacity
Tension Capacity
Moment Capacity
Reduced Moment Capacity
Shear Capacity
BUCKLING CALCULATIONS (units - kN, m)}
Lateral Torsional Buckling Moment MB = 3237
Co-efficients m & n:m=1.00n =1.00, Eifective Lengths 3 .72¢3
CRITICAL LOADS FOR EACH CLAUSE CHECK (units- kN, m) :
CLAUSE RATIO LOAD FX VY \'7A MZ MY
BS-4.7 (c) 1.003 1 2500.0 0.0 0.0 J.¢ )
STAAD SPACE -- PACE NO

Torsion and deflections have not been considered in the desigm.

-_—

Comparing the published results with those in the STAAD design:-

Published compression capacity is 2508 kN (STAAD design is 2492.2 kN)

The published design only passes as it uses the o

Iy

=y

STAAD uses those currently published by British

c=114 cm3, which is now published as 113 cm’,

Id British Steel section properties whereas
Steel in particular the printed example uses
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